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1. Verktyg/program
Vi kommer att arbeta med nedanstående program. Guiden har producerats på Ubuntu 12.04 
med Scribus 1.4.3, GIMP 2.8 och Inkscape 0.48. Till största delen är programmen översatta till 
svenska (dock återstår en del menyval med mera på engelska).

Manualen förutsätter att du kan öppna och stänga dokument i olika program, packa upp 
ZIP-filer med mera.

Scribus (formgivning)
Scribus används för formgivning (layout). Motsvarar Indesign.

Finns för Linux, Windows och Mac OS X.

Webbplats: http://scribus.net

Nedladdning: http://wiki.scribus.net/canvas/Download

Hjälp: Inbyggd samt på http://wiki.scribus.net/canvas/Help:TOC

GIMP (bildbehandling)
GIMP (uttalas ”gimp”) används för bildbehandling (målning och redigering av fotografier). 
Motsvarar Photoshop.

Finns för Linux, Windows och Mac OS X.

Webbplats:  http://www.gimp.org

Nedladdning: http://www.gimp.org/downloads/ (klicka på ”Show other downloads” för Windows 
och Mac OS X)

Hjälp: Inbyggd samt på http://www.gimp.org/docs/

Installera GIMP 2.8 på Ubuntu: http://askubuntu.com/questions/134035/how-do-i-get-gimp-2-8

Inkscape (vektorillustration)
Inkscape används för illustrationer med linjer och andra grafiska objekt. Motsvarar Illustrator.

Finns för Linux, Windows och Mac OS X.

Webbplats: http://inkscape.org

Nedladdning: http://inkscape.org/download/

Hjälp: Inbyggd samt på http://tavmjong.free.fr/INKSCAPE/MANUAL/html/index.php

LibreOffice
LibreOffice är ett fritt office-paket.

Webbplats: http://www.libreoffice.org/

Öppna filformat
Open source, eller fri programvara, handlar inte bara om program utan även öppna format. Det
innebär att vem som helst kan skriva program som hanterar informationen, och gör att 
information (text och bilder) kan skickas mellan olika program utan problem.
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2. Exempel
Målet med denna manual är att ta fram en trycksak (tryckfärdig PDF) med open 
source-verktyg.

Vårt mål är ett tvåsidigt reklamblad i A4-format. Vårt material består av

• ett textdokument med rubrik, framsidestext och baksidestext.

• två fotografier på produkten (ett med bakgrund och ett utan)

• ett fotografi som ska göras om till en logotyp

• två profilfärger

• ett profiltypsnitt

• en ICC-profil för tryck: Europa ISO Coated FOGRA27

Resultatet kan till exempel se ut så här:

Underlag till övningen kan laddas ner på http://oscillator.se/opensource.
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3. Arbetsflöde - teori
Vårt grafiska arbetsflöde, det vill säga vad vi ska göra, i vilken ordning, och med vilka verktyg, 
ser ut så här:

Det program vi inte har nämnt tidigare är Evince (som även kallas för 
Dokumentvisare/Document Viewer i Ubuntu). Det är ett program för korrektur som kan visa 
PDF-dokument och låta användaren göra anteckningar på rätt plats direkt i dokumentet.

Steg 0. Färghantering
Färghantering handlar om att det som kommer tillbaka från tryckeriet (eller visas i 
webbläsaren) ser likadant ut som det du ser på skärmen när du arbetar med bilden eller 
formger trycksaken. Se bilaga 1.

Steg 1. Manus
Med manus menas både text och bilder.

Text levereras helst som Open Document Text (.odt), RTF (.rtf) eller ren text (.txt).

Fotografier kommer ofta ur en kamera som JPEG (.jpg) eller RAW. Ett bra öppet format där ingen
kvalitet förloras är TIFF (.tif).

Vektorgrafik (bilder uppbyggda av geometriska figurer och matematiska kurvor) hanteras av 
det öppna formatet SVG (.svg), alternativt PDF (.pdf).

Vi vill ha bilder i största möjliga storlek. De anpassas till tryck när vi vet hur stor plats de ska 
fylla i trycksaken.

I detta steg får vi även typsnitt som ska användas för trycksaken. Dessa installeras på olika 
sätt för olika operativsystem. I Ubuntu dubbelklickar du på typsnittet (ett dokument som slutar 
på .otf eller .ttf) så att det förhandsvisas. Därefter klickar du på knappen Installera 
typsnitt/Install font.

Steg 2. Mall
Först skapar vi en grafisk identitet för bladet. Den består av

• sidstorlek och marginaler

• sidhuvud och sidfot

• mallsidor

• baslinjeraster (radavstånd)

• typsnitt
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• stilar (paragraf- och teckenstilar)

• färger

Ett tryckeri trycker vanligtvis på pappersark som är större än den slutliga trycksaken. 
Överflödigt papper skär de bort på slutet. Det gör att bilder kan gå ända ut till kanten utan risk 
för en vit oönskad kant.

Steg 3. Layout
I de flesta layoutprogram läggs text och bilder in i ramar. De är ofta rektangulära, men kan ha 
andra former. Textramar kan länkas samman så att texten flödar mellan dem.

Layout handlar om att ”lägga ut” saker på sidan, det vill säga ge den en form. Men en viktig del
av layouten är också att se till att vi får snygga rad- (avstavningar) och sidbrytningar.

När vi vet hur mycket plats bilderna får ta gör vi bildbehandlingen. Steg 3 (layout) och steg 4 
(bildbehandling) utförs därför ofta parallellt.

Steg 4. Bildbehandling
Det finns två olika sorters bilddokument: punktgrafik och vektorgrafik.

Punktgrafik utgörs av fotografier, digitala målningar och bilder (renderingar) från 3D-program.

En sådan bild anpassas för layout (och tryck) genom följande steg:

1. Beskärning

2. Upplösning

3. Storlek

4. Nivåer (svart- och vitpunkt)

5. Kurvor samt intensitet och kontrast (engelska: brightness and contrast)

6. Färgbalans och nyans/mättnad (engelska: hue/saturation)

7. Retuschering och borttagning av oönskade detaljer

8. Friläggning (engelska: masking)

9. Skärpa

10. Eventuellt färgseparering (det kommer vi dock att låta Scribus göra)

11. Spara dokumentet som TIFF
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Vektorgrafik är ofta ritningar och logotyper, och består av linjer (banor) och geometriska 
former.

En sådan bild anpassas genom följande steg:

• Justera eventuellt färgrymden

• Städa bort punkter och linjer som inte hör till bilden

• Kontrollera att bilden inte innehåller någon vit bakgrund som du tror är genomskinlig

• Komplexa bilder kan vinna på att förenklas, en funktion som finns i vissa program

• Spara dokumentet som SVG

Steg 5. Korrektur
Korrektur betyder att vi kontrollerar att manuset (text och bilder) har inkluderats och visas på 
ett korrekt sätt. Vi letar efter:

• stavfel (men glöm inte att köra stavningskontrollen redan innan texten lämnas för 
layout).

• avhuggen text (textramen är för liten eller inte länkad).

• dåligt textflöde: fula avstavningar, änkor (sista raden av ett stycke står överst på en 
sida) och horungar (första raden av ett stycke står längst ned på en sida)

• flera blanksteg i rad

• felaktig användning av stilar

• dålig läsbarhet (tillgänglighet), kräver en utskrift för bra bedömning

• dålig placering av bilder, textramar eller grafiska element som försvårar läsningen

Vi kan genomföra korrekturen genom att skriva ut hela dokumentet och göra anteckningar med
en vanlig penna. Eller så skapar vi en PDF och låter korrekturläsaren göra anteckningar med 
hjälp av ett program som både kan visa och anteckna i en PDF. Denna PDF kan sedan skickas 
tillbaka till den som gör layouten.

Steg 6. Tryckfärdig
Det här är det sista steget, och det består av tre delar:

1. Först kontrollerar vi att dokumentet är tekniskt färdigt för tryck. Är alla typsnitt 
inkluderade i PDF:en och i rätt format? Finns alla bilder med i rätt upplösning och 
färgrymd? Är sidstorleken rätt? Är färghanteringen korrekt?

2. Sedan skapar vi en tryckfärdig PDF. Här görs samtidigt konvertering till CMYK-färger 
(undantag: PDF/X-3). För att göra detta behöver vi en ICC-profil (som vi får från 
tryckeriet).

3. Sist av allt kan vi eventuellt kontrollera kvaliteten hos den tryckfärdiga PDF:en. Det finns
särskilda program som kan göra detta (exempelvis Adobe Acrobat Pro). En annan metod
är att göra ett provtryck hos tryckeriet.

Se bilaga 3 för mer information om PDF-dokument.
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4. Arbetsflöde - praktik
Installera Scribus, GIMP och Inkscape. Ställ om dem till svenska:

• Scribus: File > Preferences > General > Language

• GIMP: Edit > Preferences > Interface > Language

• Inkscape: File > Inkscape Preferences > Interface: Language

Om du tycker att GIMP känns enklare att hantera med allt i samma fönster (som Photoshop), 
välj Fönster > Single-window mode.

Steg 0. Färghantering
Se bilaga 2.

Steg 1. Manus
Vårt textmanus ligger i ett ODT-dokument kallat ”text.odt”. Om vi öppnar det med LibreOffice 
ser vi att det innehåller en del formattering och instruktioner om var texten ska ligga.

Vi har också tre bilder. Den första, ”pa2_head.png”, är en bild på en hjälm som vi ska använda 
för att skapa en logotyp. Den andra, ”pa2_scene.jpg”, är ett foto (egentligen en rendering från 
ett 3D-program). Den tredje, ”pa2_figure.png”, är ett foto (rendering) utan bakgrund.

Vi har dessutom en beskrivning över vilket typsnitt och vilka färger som ska användas i 
ODT-dokumentet ”info.odt”.
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Steg 2. Mall
I denna guide gör vi dessa steg i en bestämd ordning. Men i praktiken hoppar vi ofta fram och 
tillbaka mellan dem eftersom de olika stegen interagerar med varandra.

Konfigurera Scribus genom att skapa ett nytt dokument, Fil > Ny, och anger följande värden:

• Standardmåttemhet: Millimeters (mm)

• Dubbelsidig

• Storlek: A4

• Orientering: Porträtt

• Bredd: 210 mm

• Höjd: 297 mm

• Första sidan är: Höger sida

• Insida: 25 mm

• Yttersida: 20 mm

• Överst: 20 mm

• Nederst: 25 mm

• Antal sidor: 2

Innan vi trycker på OK klickar vi på fliken Bleeds (Utfall) och anger 5 mm för alla sidor.
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Steg 2a. Ställ in Scribus
Ställ in ytterligare inställningar genom menyvalet Fil > Dokumentinställningar (flera av 
valen är redan inställda, vi bryr oss inte om att vissa värden ”avrundats” till närliggande 
värden):

• Stödlinjer: Kryssa i Visa rutmönster av baslinjer och ange Mönster av baslinjer 
till 14pt och Baslinjer offset till 20mm (samma som marginalen i överkant). 
Baslinjerna hjälper oss att arbeta med radavstånd på ett konsekvent sätt.

• Avstavare: Kryssa i Avstava texten automatiskt vid inskrivning.

• Teckensnitt: För de typsnitt som vi ska använda, se till att Delmängd ej är förkryssad 
(typsnitten ska ej omvandlas till banor vid utskrift till PDF).

Scribus: Verktyg
Alla Scribus verktyg ligger i en palett som kan ligga horisontellt eller 
vertikalt. För att placera om den, ta tag i palettens ”huvud” (ser ut som 
tre prickar) och dra den. De flesta verktyg har dessutom ett 
kortkommando, en tangent, som aktiverar dem. Det är framförallt 
nedanstående verktyg som vi kommer att använda.
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Obs. I en grundinstallation av Scribus är denna verktygslist placerad i 
fönstrets överkant. För att få den att bli en vertikal verktygslist, dra i de 
små punkterna i början av den.

Steg 2b. Färger
Välj Redigera > Färger. Ta bort alla färger utom Black, Registration och White.

Lägg till de två nya färgerna (”Grön” och ”Gul”) enligt definitionerna. Färgmodellen ska vara 
CMGS (CMYK).

Steg 2c. Stilar
Installera de typsnitt som ska användas.

I stilmallar anges de typsnitt, storlekar, indrag etc som ska användas på texten. Det gör det 
enklare att få ett konsekvent utseende på trycksaken och underlättar också ändringar.

Det finns två sorters stilmallar: teckenformat och styckeformat. teckenformat gäller för ett 
antal bokstäver i följd och används oftast för ord, namn eller begrepp som ska stå ut i texten. 
styckeformat används för att ge hela stycken en viss karaktär.

Skapa stilmallarna genom Redigera > Stilmallar. Scribus har två grundstilar, en för vardera 
stiltyp: ”Default character style” och ”Default paragraph style”. Vi börjar med att definiera 
dessa så kan senare stilar bygga vidare på dem.
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Markera ”Default character style” och ge egenskaperna: typsnittet Orbitron Light, 12 punkter, 
svenska språket.
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Markera sedan ”Default paragraph style” och se till att radavståndet (under Distances and 
Alignment är inställt på Justera mot baslinjemönster. På så sätt kan vi hålla samma 
radavstånd oavsett placering på sidan.
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Under fliken Character style anger vi vilket teckenformat som stilen ska baseras på: ”Default 
Character Style”.

Nu skapar vi de stilmallar som vi kommer att använda (i praktiken skapar vi ofta mallarna allt 
eftersom formen ”växer fram”). Ange namn och värden enligt följande på samma sätt som du 
ändrade ”Default Paragraph Style” och ”Default Character Style” fast klicka först på Ny > 
Styckemallar.

Styckeformat:

• ”Brödtext”: Based on: ”Default Paragraph Style”. Justering: Vänsterjusterad (fjärde 
symbolen). Indrag från första raden i stycket: 14pt (samma som radavståndet).

• ”Brödtext - första raden”: Based on: ”Brödtext”; Indrag från första raden i stycket: 
0pt.

• ”Rubrik”: Based on: ”Default Paragraph Style”, Justering: Vänster. Character style: 
Stil: Black. Teckengrad: 28pt. Färger: Fyll (”hink”) ”Grön”.

• ”Inledning”: Based on: ”Default Paragraph Style”, Justering: Vänsterjusterad. 
Character style: Family: Orbitron. Stil: Medium. Teckengrad: 20pt.

• ”Citat”: Based on: ”Brödtext - första raden”. Left indent: 14pt. Right indent: 14pt.

• ”Sidfot”: Based on: ”Default Paragraph Style”. Radavstånd: 14pt. Justering: 
Centrerad. Character style: Stil: Black. Teckengrad: 10pt. Obs. För att kunna ange 
ett exakt radavstånd (14 pt) måste du under Distances and Alignment ange 
radavståndet till Fast radavstånd.
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Teckformat (klicka på Ny > Character Style):

• ”Namn”: Based on: ”Default Character Style”, Stil: Bold.

Steg 2d. Mallsidor
Först ska vi skapa mallsidor för fram- och baksida. I dessa lägger vi

• sidhuvud och sidfot

• stödlinjer

Mallsidor kan innehålla text och bilder samt stödlinjer som ligger bakom det material som 
placeras på den ”riktiga” sidan. Mallsidan är bakgrunden till sidan. En tidning använder ofta 
flera olika mallsidor, exempelvis en mallsida för nyheter med fyra kolumner och ett särskilt 
sidhuvud, en annan för reportage med tre kolumner och annat sidhuvud.

Scribus: Flytta omkring i dokumentet
Tryck ned och släpp mellanslagstangenten. Då förvandlas pekaren till en 
hand och vi kan flytta omkring på sidan med vänster musknapp. Vi kan 
också flytta omkring genom att hålla ned Ctrl och dra med höger 
musknapp eller genom att hålla ned mellersta musknappen (hjulet) på 
en treknapparsmus. Vi kan zooma med Ctrl och mushjulet. Att bara 
snurra på mushjulet panorerar dokumentet vertikalt.

Välj Redigera > Mallsidor. Från början finns två mallsidor, ”Normal Left” och ”Normal Right”. 
Klicka på ”Normal Right”, framsidan på vårt faktablad. Vi kommer endast att ha en sidfot med 
sidnummer.

Vi börjar med att skapa en stödlinje för sidfotens textram. Se till att verktyget Välj objekt är 
valt. Håll ned musen (vänsterknapp) över linjalen och dra ned en stödlinje till under den undre 
marginalen (runt 287 mm).

Den här stödlinjen använder vi för att placera textrutan. Välj Sida > Lås till stödlinjerna.

Välj Infoga > Insert Text Frame (eller klicka på verktyget eller tryck T) och dra och släpp så 
att det skapas en rektangel i mitten under stödlinjen. Låt den bli ca 1,5 rad hög
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Se till att rektangeln är vald (har en röd ram) och tryck F2 för att visa egenskaper (eller välj 
Fönster > Egenskaper). Under fliken Text > Inställningar stilmallar, välj Paragraph 
style: ”Sidfot”.

Välj verktyget Redigera raminnehåll (eller tryck tangenten E). Välj Infoga tecken > 
sidnummer. Då kommer rätt sidnummer automatiskt att visas för alla sidor som använder 
denna sidmall.
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Vi vill också att sidfoten ska ha en färgad bakgrund. Välj verktyget Insert Shape och dra en 
rektangel kring nederdelen av sidan, ända ut till utfallet. Välj Item > Nivå > Lägg underst så 
att rektangeln hamnar under sidnumret. I Egenskaper klickar vi på Färger för att ta bort 
ramen och fylla den med färgen ”Gul”.

Sidnumrets övre kant hamnar dock alltför nära den gula rektangelns övre kant, så vi ser till att 
innehållet (sidnumret) hamnar en bit ned. Med textramen vald väljer vi i Egenskaper Text > 
Columns & Text Distances. Sätt Topp till 2mm.

Upprepa samma åtgärder för ”Normal Left”.

Stäng fönstret Redigera mallsidor för att återgå till att redigera de vanliga sidorna.

Vi ska slutligen se till att de två vanliga sidorna använder rätt mallsidor. Välj Fönster > Ordna 
sidor. I fönstret Arrangera sidor kan du dra ned sidmallarna från Tillgängliga mallsidor till 
den sida under Dokumentsidor som du vill ska baseras på mallen.
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Steg 3. Layout
Infoga en textram och med ramen markerad välj i snabbmenyn (högerklick) Hämta text (Ctrl 
+ I). Se till att Import Text Only är förkryssad eftersom Scribus i nuläget inte importerar 
formatmallar på ett korrekt sätt.

Nu finns all text importerad i en textram. Med textramen markerad, välj i Egenskaper Text > 
Inställningar stilmallar stilen ”Brödtext”.

För att redigera innehållet i en textram klicka på verktyget för Redigera raminnehåll. För att 
redigera ramen klicka på verktyget för Välj objekt (eller tryck på tangenten C, vilket av 
uppenbara skäl inte går då du redigerar text).

Med dessa verktyg och menyvalen för kopiera och klistra in kan vi fördela texten över de två 
sidorna i flera textramar.

Scribus: Växla sida och zooma
Du byter sida och zoomar med verktygslisten längst ned i fönstret

:

Scribus kan länka samma flera textramar och låta texten flöda mellan dem (de fungerar som 
en enda stor textram). Gör så här:

1. Skapa en första textram och importera eller klistra in text i den.

2. Skapa fler textramar.

3. Markera den första textramen, klicka därefter på verktyget Länka textramar (eller 
tryck på N), och klicka på nästföljande textram.

4. Fortsätt på liknande sätt med resten av textramarna.

Länkar mellan textramar kan tas bort genom verktyget Avbryt länk mellan textramar.
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Länkarna visas som pilar om du väljer Vy > Visa textflöde.

Applicera styckeformatet ”Citat” genom att markera raderna med citat och välja Egenskaper 
> Text > Inställningar stilmallar > Paragraph style: ”Citat”.

Applicera teckenformatet ”Namn” genom att markera namnen i stycket med citat och välja 
Egenskaper > Text > Inställningar stilmallar > Character style: ”Namn”.

Gör samma sak med formaten ”Rubrik”, ”Inledning” och ”Brödtext - första raden”.

Slutligen bör du ha en layout som ser ut ungefär så här:

Scribus: Visa utan störande stödlinjer och guider
För att visa sidan ungefär som den kommer att se ut vid utskrift, välj Vy 
> Preview Mode.
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Steg 4. Bildbehandling
Vad som nu återstår är att infoga en bild på framsidan (sidan 1), en bild på baksidan (sidan 2) 
och en logotyp på baksidan (sidan 2).

Vi börjar med bilden på framsidan (”pa2_scene.jpg”) och anpassar bilden för layout (och tryck) 
genom de steg vi tidigare nämnt.

När vi öppnar en bild i GIMP undersöker programmet om bilden redan har en färgprofil. Om så 
är fallet kommer GIMP att fråga om vi vill konvertera till den färgprofil för RGB som vi angav vid
inställningen av färghantering (Redigera > Inställningar > Färghantering: RGB-profil). 
Om bilden inte har någon profil så används den från inställningarna. Vi väljer att behålla 
bildens färgprofil. (Läs mer om färghantering i bilaga 1 och 2.)

1. Beskärning
Vi ska ha med hela bilden och kommer alltså inte att beskära den (ta bort något).

2. Upplösning
Om vi åter tittar på layouten av framsidan i Scribus, så kan det ser bra ut som bilden går över 
hela den horisontella ytan, från vänsterkant till högerkant (landskapsorientering). Eftersom det 
är ett A4-ark, så är bredden 21 cm, med utfall på båda sidorna totalt 22 cm.

Vi arbetar med upplösning 300 dpi (dots per inch), vilket är normalt vid vanligt tryck. Eftersom 
en inch, en tum, är 2,54 cm, motsvarar 300 dpi 118 pixels/cm. Vår bild måste alltså vara 22 cm
* 118 pixlar bred = 2596 pixlar.

Öppna ”pa2_scene.jpg” i GIMP. Välj Bild > Utskriftsstorlek. Ändra enheten till cm, och skriv 
in 300 som upplösning (bildenheter/in). Bilden visar sig då vara nära 22 cm, vilket är precis 
vad vi behöver.

3. Storlek
Använd Bild > Skala bild för att kontrollera antalet pixlar och eventuellt skala om bilden. Det 
behöver vi inte den här gången.

4. Nivåer (svart- och vitpunkt)
Att sätta svart- och vitpunkt handlar om att utnyttja hela den dynamik som är möjlig i bilden, 
så att det som ska vara svart verkligen är det, och det som ska vara vitt verkligen är vitt.

Använd Färger > Nivåer.
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Diagrammet visar hur färgmängden fördelar sig från svart till vitt. Det här är en ganska mörk 
bild. Svartpunkten (den svartaste punkten) kan flyttas antingen genom att dra i den svarta 
triangeln under diagrammet, eller genom att klicka på pipetten med svart färg och därefter 
klicka på det svartaste området i bilden. På liknande sätt fungerar vitpunkten.

För den här bilden behöver vi inte göra några förändringar.
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5. Kurvor samt intensitet och kontrast
Kontrasten och ljusheten i en bild justeras bäst genom Färger > Kurvor.

Kurvan visar hur färgtoner i bilden ska omvandlas till nya färgtoner. X-axeln är in-värdet och 
Y-axeln är ut-värdet. Håll ned muspekaren över mitten av kurvan och dra den upp och ned för 
att se hur bilden förändras. Om du önskar en ljusare bild, dra kurvan uppåt. Fler punkter kan 
läggas till på kurvan genom att klicka och dra på olika ställen.

Vi drar upp de mörka värdena något utan att ändra de ljusa (lägg till en punkt) för att på så sätt
få fram mer detaljer i rustningen.

(Om du vill kan dessa förändringar, liksom de flesta andra i denna lista, göras enbart på 
markerade områden.)
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6. Färgbalans och nyans/mättnad
Med Färger > Färgbalans går det att justera balansen (förhållandet) mellan olika färgpar i 
bilden. Dra i de tre handtagen för att ändra bilden.
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Med Färger > Nyans-mättnad går det att påverka enstaka färger. Välj den färg du vill ändra, 
dra sedan i handtagen Nyans (färgton), Ljusstyrka och Mättnad (mängden färg) för att 
ändra den.

Båda dessa justeringar görs bäst genom att på något sätt veta hur originalvyn var. Om 
exempelvis en fotograf har tagit bilden, så är det bäst att låta hen göra justeringar eftersom 
hen var med vid fotograferingstillfället.

7. Retuschering och borttagning av oönskade detaljer
Nu är det dags att ta bort sådant vi inte vill ha kvar i bilden. Kanske är det damm som har suttit
på kamerans objektiv eller glasskivan på vår scanner? Eller röda ögon på ett fotografi?

Använd GIMP:s maskerings- och målningsverktyg för att göra ändringar i bilden. Det kan vara 
en god idé att skapa lager för att undvika att förändra de delar av bilden som nu är justerade. 
Kloningsverktyget är ofta det bästa valet.
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I vårt fall använder jag klonings-, oskärpe- och smetningsverktyget för att ta bort den störande 
svarta randen på trädstammen i bakgrunden.

8. Friläggning
Friläggning innebär att ta bort saker i bilden som inte ska vara med, i praktiken ofta att plocka 
bort en bakgrund från ett fotografi på en människa eller en sak.

Bäst görs detta inte genom att sudda bort delar utan genom att skapa en särskild bana. Den 
ser dels till att bakgrunden inte visas, men kan dessutom ”stöta bort” text som eventuellt ska 
flöda runt bilden. Vi visar detta senare i guiden.

9. Skärpa
När en bild trycks förlorar den ofta i skärpa genom att färgerna flyter ut lite i pappret. Det kan 
vi kompensera genom att ge bilden lite överdrivet extra skärpa innan den trycks.
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Använd Filter > Förbättra > Oskarp mask. Lämpliga värden:

• Radie: 0,8-1,6

• Mängd: 0,5-2 

• Tröskelvärde: 7-9

10. Eventuellt färgseparering
Scribus ordnar detta när vi skapar PDF:en så vi hoppar över det här steget (i vårt arbetsflöde).

11. Spara som TIFF
Spara först bilden med samma namn fast i GIMP:s eget format (.xcf) med hjälp av Arkiv > 
Spara som... Den versionen har vi kvar om vi vill göra fler ändringar i bilden. Spara sedan 
dokumentet som TIFF (.tif) med hjälp av Arkiv > Exportera... Välj ingen komprimering. 
Namnet ska vara ”pa2_scene.tif”.

12. Infoga bilden i Scribus
Vi monterar nu bilden i Scribus på framsidan av dokumentet.

Zooma först ut så att du ser hela dokumentet. Välj Infoga > Insert Image Frame och dra en 
rektangel som sträcker sig tvärs över hela sidan, från vänster utfall till höger utfall.

Med rektangeln markerad, högerklicka för att få upp snabbmenyn, och välj Hämta bild. Välj 
”pa2_scene.tif”. Den läses in och placeras i dokumentet.

Högerklicka på bilden och välj Justera ramen till bild. Vi har nu en ram som precis matchar 
bilden.

Klicka på Egenskaper > Bild. Anpassa storleken ska vara förkryssad för att du ska kunna 
ange hur stor bilden egentligen ska vara i rutan. Om du väljer Skala till ramstorlek och 
Proportionellt kan du ändra bildens storlek genom att ändra ramens storlek. Det är dock 
inget bra alternativ om du ha kontroll över bildens upplösning.

Flytta bilder
För att flytta omkring bilden på sidan, byt till verktygen Välj objekt och 
dra omkring bilden. För att begränsa rörelserna till antingen vertikalt 
eller horisontellt, håll ned Ctrl efter att du börjat dra.
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Nu ska vi göra samma sak för att få in bilden ”pa2_figure.png” på baksidan. Den har dock 
ingen bakgrund så vi skapar en friläggning.

8. Friläggning
Öppna ”pa2_figure.png” i GIMP. Bilden har en genomskinlig bakgrund (eller rättare sagt, saknar
bakgrund). Välj Bild > Utskriftsstorlek och sätt dpi till 300. Skala ej om bilden.

Utför samma bildbehandling som för den andra bilden.

Så här gör du friläggningen:

1. Välj Luddigt markeringsverktyg (”trollspöet”) och klicka någonstans utanför figuren. 
Det kan ta ett tag eftersom bilden är stor och innehåller många bildpunkter (pixlar).

2. Välj Markera > Invertera så att figuren är markerad.

3. Vi vill se till att när vi placerar bilden i Scribus, så ska texten inte gå alltför tätt inpå 
bilden. 5 mm är ett lagom avstånd, så välj Markera > Förstora, 5mm. 

4. Välj Bild > Beskär till markering.

5. Välj Fönster > Dockningsbara dialoger > Slingor (eller klicka på Slingor-panelen).
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6. Klicka på knappen för Markering till slinga eller välj det i panelens meny (Slingmeny
> Markering till slinga).

Fortsätt eventuellt med bildhanteringen (steg 9) och spara som en TIFF med namnet 
”pa2_figure.tif”.

Nu är det dags att placera bilden på baksidan av Scribus-dokumentet. Skapa en bildram, 
importera bilden och justera ramen till bilden.

Högerklicka på bilden och välj Utökade bildegenskaper. Under Egenskaper > Form > Text
flow around frame välj Use Image Clip Path.

Flytta runt bild- och textrutor och ändra placering och storlek på både text- och bildrutor för att
nå en bra form på baksidan.
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Scribus: Alternativ för friläggning/textflöde
Det går även att exportera slingan (banan) som en SVG-fil som du sedan
kan importera till Scribus. SVG-dokumentet kan senare justeras 
(storleksförändras) för att hantera textflödet.

Logotyp
Vi ska nu göra en logotyp som vektorgrafik med hjälp av Inkscape. Den ska vi basera på bilden 
”pa2_head.png”.

Starta Inkscape. Välj Arkiv > Importera och välj ”pa2_head.png”. Flytta huvudet och skala om
med hjälp av handtagen runt huvudet (håll ned Ctrl för att skala proportionerligt).
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Se till att huvudet är markerat och välj Slinga > Kalkera bitmappsbild.

I dialogrutan, välj En omgång: Skapar en slinga, kryssa i Ljusstyrka och höj tröskelvärdet 
till 0,99 så att alla färger detekteras. Klicka Uppdatera för att se hur det kommer att bli. Klicka
därefter OK.

Ta bort den importerade bilden, markera vektorbilden och välj verktyget Editera slingors 
noder (eller tryck F2).

Markera och ta bort (med Del-tangenten) noderna kring ögonen så att vi har en ren silhuett.

Vi vill nu ge huvudet vår gröna profilfärg. Den är dock definierad i CMYK, vilket SVG-dokument 
normalt inte kan hantera. Men det finns en lösning. Välj Arkiv > Dokumentegenskaper. 
Klicka på fliken Color Management och välj profilen ”Europe ISO Coated FOGRA27”. Klicka på 
Link Profile.
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Tryck Shift+Ctrl+F för att visa panelen för färger. Klicka på fliken Color Management, välj 
färgprofilen i popup-listan och ange värdena för vår gröna profilfärg (33, 0, 95, 71).

Inkscape: Mer om CMYK-färger
http://libregraphicsworld.org/blog/entry/getting-cmyk-colors-from-inksca
pe-to-scribus

På grund av en bugg i hur Inkscape hanterar vissa ICC-profiler, kan det 
hända att denna dialogruta inte fungerar. Ladda i så fall ner en 
fungerande ICC-profil för tryck på http://oscillator.se/opensource 
(”Alternativ ICC-profil för tryck för Inkscape”). Läs mer om denna bugg 
på https://bugs.launchpad.net/inkscape/+bug/632023.

Nu lägger vi till bokstaven ”O” på huvudet. Klicka på verktyget Skapa och redigera 
textobjekt (F8). Dra och skapa en textruta över huvudet. Välj menyvalet Text > Text och 
typsnitt. Ange där ”Orbitron”, Bold, 72 punkter. Klicka på Verkställ och Stäng. Skriv 
bokstaven ”O”. Välj pilen (Markera och transformera objekt), välj Slinga > Objekt till 
slinga. Välj Slinga > Dela upp (för du vill enbart arbeta med en bokstav. Bokstaven är nu en 
bana (slinga) vilket är lättare att arbeta med grafiskt. Förstora om nödvändigt bokstaven (dra i 
en hörnpil och håll ned Ctrl för proportionerlig förstoring).
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Vi vill nu stansa ut ett hål med bokstavsformen. Markera både huvudet och bokstaven och välj 
Slinga > Differens. (I denna bild har jag lagt en rosa platta i bakgrunden för att visa att vi nu 
har ett hål i hjälmen.)

Välj Arkiv > Spara som... och ge bilden namnet ”logo.svg”, filformat Inkscape (SVG) 
(*.svg).

Arbeta åter i Scribus. Vektorgrafik/bilder placeras inte i ramar i Scribus utan importeras. (Det 
gör att du senare kan arbeta vidare med vektorgrafiken inuti Scribus.) Välj Importera > Get 
Vector File, välj ”logo.svg” (ignorera varningen), klicka på sidan för att placera bilden. Skala 
ned den genom att dra i ett av bildens hörn och håll ned Ctrl för att skala proportionerligt. (Välj 
Redigera > Färger för att se att den gröna färgen har importerats rätt.)
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Skapa en liten textruta under logotypen och klistra in den sista texten. Skapa en ny formatmall 
för texten eller använd exempelvis ”sidfot”.

Spara dokumentet som ”exempel.sla”.
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Steg 5. Korrektur
Det här steget beskriver hur du kan utföra korrektur om du har en annan person som ska läsa 
igenom dokumentet. Om du gör korrekturen själv kan du i stället titta och ändra direkt i 
Scribus.

Beskrivningen av hur du gör en PDF med skärmupplösning kan du dock också ha glädje av om 
du ska göra ett dokument för nedladdning och läsning på skärmen eftersom det inte kommer 
att ta så mycket plats som en tryckfärdig PDF.

Vi skapar först en PDF med skärmupplösning med hjälp av Scribus. Sedan kan korrekturläsaren 
betrakta den i en PDF-läsare, göra korrekturanteckningar, och skicka tillbaka denna så att vi 
kan genomföra korrekturen i Scribus.

Välj Fil > Exportera > Spara som PDF... för att skapa en PDF i Scribus. Först görs en så 
kallad preflight, dokumentet kontrolleras för olika fel. Välj PDF 1.4 för Aktuell profil (se bilaga
4 för mer information om olika PDF-format). Rätta eventuella fel och klicka därefter på OK. En 
dialogruta för PDF-exporten visas. Ge den filnamnet ”exempel_72dpi.pdf” och ange följande 
under flikarna:

• Skicka en fil för varje sida: ej förkryssad.

• Allmänt: Alla sidor, PDF 1.4, Maximum image resolution: 72 dpi.

• Teckensnitt: Klicka på Embed all för att ta med alla typsnitt i dokumentet.

• Extra: Aktivera presentationseffekter: ej förkryssad.

• Viewer: Enkelsidig, Use viewers default.

• Säkerhet: Använd kryptering: ej förkryssad.

• Färg: Utmatningen är avsedd för Skärmen/webben.

• Pre-Press: Inga Printer marks och inget utfall (bleed sätts till 0 mm)

Klicka på Spara för att skapa PDF-dokumentet.

På Ubuntu kan vi använda Evince/Dokumentvisare för att se PDF:en och göra anteckningar. 
Starta Evince/Dokumentvisare och öppna PDF:en. Välj Visa > Sidopanel och välj 
Kommentarer i listan. Klicka på Lägg till och markera området som ska kommenteras. Skriv 
korrektur i den gula rutan som visas. När dokumentet är genomläst, välj Arkiv > Spara en 
kopia... för att spara dokumentet med kommentarerna.

I ett riktigt flöde skickas PDF:en med anteckningar tillbaka till layoutaren som genomför 
korrekturet.
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Steg 6. Tryckfärdig
När dokumentet är korrigerat återstår slutligen endast att skapa den tryckfärdiga PDF:en.

Välj Fönster > Verifiera (Pre-flight). Preflight-kontrollen bör nu gå utan problem. Välj 
PDF/X-3 för Aktuell profil.

Välj Fil > Exportera > Spara som PDF...  En dialogruta för PDF-exporten visas. Ge den 
filnamnet ”exempel_300dpi.pdf” och ange följande under flikarna:

• Skicka en fil för varje sida: ej förkryssad.

• Allmänt: Alla sidor, PDF/X-3, Komprimera text och vektorgrafik: förkryssad. 
Komprimeringsmetod: Automatisk. Komprimeringskvalitet: Maximum. 
Maximum image resolution: ej förkryssad.

• Teckensnitt: Klicka på Embed all för att ta med alla typsnitt i dokumentet.

• Extra: Aktivera presentationseffekter: ej förkryssad.

• Viewer: Enkelsidig, Use viewers default.

• Säkerhet: Använd kryptering: ej förkryssad.

• Färg: Utmatningen är avsedd för Printer (ej möjligt att ändra). Omvandla 
tonplattor till processfärger: förkryssad.

• Pre-Press: Inga Printer marks. Bleed settings: Use document bleeds. 
Utmatningsprofil: ”Europe ISO Coated FOGRA27”. Informationssträng: 
”example_300dpi.sla”.

Klicka på Spara för att skapa PDF-dokumentet.
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5. Fler resurser

Fri programvara och grafisk produktion
• Libre Graphics Production (guider för bok- och tidningsproduktion)

http://libregraphicsproduction.com

• Libre Graphics Magazine (nyheter och artiklar)
http://libregraphicsmag.com/

• Libre Graphics World (nyheter och guider)
http://libregraphicsworld.org

Öppna typsnitt
• Open Font Library

http://www.openfontlibrary.org/

• The League of Movable Type
http://www.theleagueofmoveabletype.com/

• OSP Foundry
http://ospublish.constantvzw.org/foundry/

• VTF Type Foundry
http://velvetyne.fr/

• Bok om FontForge, ett program för att skapa egna typsnitt
http://www.booki.cc/fontforge/_draft/_v/1.0/introduction/

Öppen vektorgrafik
• Open Clip Art Library

http://www.openclipart.org/

Övrigt
• Open Source Alternatives

http://www.osalt.com/graphic-applications
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Bilaga 1. Färghantering - teori
Färghantering ser till att rätt färger bibehålls genom hela produktionen, och att vad som 
kommer ut ur tryckpressen är vad vi räknade med

Färghantering - en snabbkurs
Rätt färger bibehålls med hjälp av ett CMS (Color Management System/Färghanteringssystem), 
som i sin tur använder färgprofiler (ICC profiler) som beskriver hur färgnummer i ett dokument 
ska översättas till de färger som kan ses.

Detta innebär att varje in- och utenhet (kameror, scanners, skärmar, skrivare, tryckpressar) har
sin egen färgprofil, och att alla bilder ”taggas” (märks upp) med denna vid inläsning eller 
fotografering. När det gäller skrivare/tryckpressar så har de ofta flera ICC-profiler beroende på 
papperstyp (bestruket och obestruket papper).

Alla bilder existerar i en given färgrymd. Till exempel så märker en kamera upp alla bilder den 
tar med sin egen färgprofil. Detta talar om hur en viss färg lagras i kameran. Bilddokumentets 
råa data (som är en massa nummer) kombinerat med kamerans ICC-profil och bildskärmens 
ICC-profil gör att det vi sedan ser på skärmen ser ut som det vi fotograferade.

(Färgrymden kan också vara en enhetsoberoende arbetsrymd, till exempel sRGB IEC6i966-2.1 
eller Adobe RGB, som används när vi konverterar mellan olika färgrymder.)

Skapa ett färghanterat arbetsflöde
Följande steg är nödvändiga:

1. Installera en CMS

2. Kalibrera skärmen

3. Ställ in programmen som används (GIMP, Scribus, Inkscape etc)
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Bilaga 2. Färghantering - praktik
Vi skapar ett färghanterat arbetsflöde genom att:

1. Installera en CMS

2. Kalibrera skärmen

3. Ställ in GIMP

4. Ställ in Inkscape

5. Ställ in Scribus

Vårt exempel använder sig av Ubuntu (12.04).

Vi behöver också ICC-profiler. Dessa får vi normalt från tryckeriet, men för denna övning är det 
bra att ladda in några standard-profiler:

• Ubuntu: Hämta ”icc-profiles” via exempelvis Synaptic.

• Windows: http://www.adobe.com/support/downloads/iccprofiles/iccprofiles_win.html

• Mac: http://www.adobe.com/support/downloads/iccprofiles/iccprofiles_mac.html

Detta gäller för Ubuntu (Linux):

• ICC-profil för tryck ska ligga i ~/.color/icc.

• Inkscape vill ha den i ~/.local/share/color/icc.

Installera en CMS
Ubuntu har inbyggt stöd för färghantering och stödjer bland annat kalibreringshårdvaran 
Spyder3Express. Du behöver alltså inte installera något. Detta gäller även för (senare versioner
av) Windows och Mac OS X.

Kalibrera skärmen
Mjuk- och hårdvaran för skärmkalibrering undersöker bildskärmen och skapar en ICC-profil som 
beskriver hur just den bildskärmen visar färger. Ubuntu använder sig av GNOME Color Manager,
men vi behöver också en särskild hårdvara som läser av skärmen, en så kallad kolorimeter. Det
finns en öppen sådan kallad Color Hug.

Med Ubuntu och en Spyder3Express är det bara att sätta i USB-sladden och följa 
instruktionerna på skärmen för att skapa en ICC-profil för bildskärmen.

Detta gäller för Ubuntu (Linux):

• Kopiera skärmprofilen från ~/.local/share/icc till ~/.color/icc. 

• Inkscape vill ha den i ~/.local/share/color/icc. 

Du kan kontrollera Ubuntus inställningar för färghantering genom att köra programmet 
Färg/Color.
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Ställ in GIMP
Vi kommer att arbeta med fotografier i färgrymden RGB. Vi behöver göra två saker för att 
färghanteringen ska fungera med GIMP:

Steg 1. Redigera > Inställningar > Färghantering

• Åtgärdsläge: Färghanterad display (ställ in på Utskriftssimulering om du vill göra 
så kallad soft proof).

• RGB-profil: ”sRGB” eller ”Adobe RGB” (arbetsprofil för öppna bilder).

• CMYK-profil: I vårt exempel ”Europa ISO Coated FOGRA27” (CMYK-profil för 
färgkonvertering - vilket vi inte gör i GIMP).

• Skärmprofil: Välj den profil vi skapade vid kalibrering av skärmen.

• Visa återgivningsmetod: Perceptuell (bäst för fotografier).

• Profil för utskriftssimulering: Den profil vi får från tryckeriet, sätt till samma som 
CMYK-profil ovan (den profil som används när Åtgärdsläge är satt till 
Utskriftssimulering). 

• Softproof återgivningsmetod: Perceptuell (bäst för fotografier).

• Markera färger utanför färgomfång: Det är användbart att se vilka färger som inte 
kan tryckas, men GIMP verkar inte kunna hantera detta ordentligt, så slå av det.
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• Beteende för filöppning: Fråga vad som ska göras.

Steg 2. Visa > Visningsfilter

Se till att Färghantering är aktiv (placerad till höger och förkryssad).

Filtret Färgprov har fått ta emot en del kritik så vi använder i stället Åtgärdsläge: 
Utskriftssimulering (från steg 1).
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Ställ in Inkscape
Inkscape arbetar alltid i sRGB (SVG hanterar inte CMYK-färger). I praktiken är detta inget problem 
eftersom färgsepareringen kommer att hanteras av Scribus.

Ställ in Inkscape för färghantering, Arkiv > Inställningar för Inkscape > Färghantering:

(Gränssnittets översättning är inte komplett.)

• Display profile: Välj den profil vi skapade vid kalibrering av skärmen.

• Display rendering intent: Perceptual eller Relative Colorimetric.

• Simulate output on screen: Förkryssad.

• Mark out of gamut colors: Förkryssad.

• Device profile: Den profil vi får från tryckeriet, i vårt exempel ”Europa ISO Coated 
FOGRA27”.

• Device rendering intent: Perceptual eller Relative Colorimetric.

• Black point compensation: Förkryssad.

Vad du ska väja som x eller y beror på om bilden du arbetar med är fotografisk eller mer som 
en logotyp. Eftersom vi vill göra en logotyp väljer du Relative Colorimetric. Se bilaga 3 för 
mer information.

Visa > Color-managed view: Förkryssad.
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Inkscape: CMYK

För att arbeta med CMYK-färger i Inkscape, följ dessa instruktioner: 
http://libregraphicsworld.org/blog/entry/getting-cmyk-colors-from-inkscape-to-scr
ibus
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Ställ in Scribus
Om Scribus redan är igång, avsluta och starta om programmet så att den hittar de nya 
färgprofilerna.

Fil > Inställningar > Färghantering (eller Fil > Dokumentinställningar > 
Färghantering om dokumentet redan är öppet):

(Gränssnittets översättning är inte komplett.)

• Aktivera färghantering: Förkryssad.

• RGB Images: Den färgprofil som använts vid skapandet av bilder i RGB. Använd ”sRGB 
IEC61966-2.1”. Om bilderna redan är taggade med en ICC-profil kommer den att 
användas.

• CMYK Images: Den färgprofil som använts vid skapandet av bilder i CMYK. Använd 
”Europa ISO Coated FOGRA27”. Om bilderna redan är taggade med en ICC-profil 
kommer den att användas.

• RGB Tonplattor: Den färgprofil som ska användas för de RGB färger som skapats och 
används i Scribus. Använd ”sRGB IEC61966-2.1”.

• CMYK Tonplattor: Den färgprofil som ska användas för de CMYK färger som skapats 
och används i Scribus. Använd ”Europa ISO Coated FOGRA27”.

• Monitor: Välj den profil vi skapade vid kalibrering av skärmen.

• Skrivare: Den profil vi får från tryckeriet. Använd ”Europa ISO Coated FOGRA27”.

• Återgivningsavsikt > Bilder: Perceptuell.

• Återgivningsavsikt > Tonplattor: Relativ kolormetri.

• Simulera skrivare på skärmen och Konvertera alla färger till skrivarens 
färgrymd: Förkryssade om Scribus ska visa färger så som den slutliga utskriften kommer att bli.
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• Används svartpunktskompensation: Förkryssad.

44



Staffan Melin – Grafisk produktion med fria verktyg

Bilaga 3. Ännu mer om färghantering
Färghantering är komplext. När du har färghantering aktiverad i program och operativsystem 
så ser de till bildens färger visas korrekt på skärmen.

Vad som egentligen sker är att bildens färgvärden räknas om av färghanteraren. Den använder 
i sin tur både bildens och utenhetens (vanligtvis skärmens eller skrivarens/tryckeriets) 
ICC-profil. Detta sker dock i flera steg och är inte helt entydigt eftersom alla färgrymder inte 
innehåller alla färger. En skärm kan visa fler färger än en skrivare.

Enkelt uttryckt räknas färgerna i ett mellanled om till en arbetsrymd som är entydig, CIELAB. 
För att veta hur dessa färger sedan ska visas/skrivas ut används en Rendering Intent. Den 
anges ofta på ett av följande sätt för att hantera att färgrymden på utenheten är mindre än 
färgrymden hos indata.

Absolute colorimetric
Färgernas värden översätts inte utan skickas vidare utan förändring. Det innebär att 
färgvärderna är rätt men kan se fel ut.

Relative colorimetric
Samma som Absolute colorimetric men hänsyn tas till medias så kallade vitpunkt. Både 
Absolute colorimetric och Relative colorimetric är användbara när färger behöver återges 
exakt, exempelvis för logotyper.

Perceptual och Saturation
Perceptual används normalt för fotografier, eftersom färgernas inbördes förhållande bibehålls. 
Denna ”rendering intent” behåller med andra ord dynamiken i (skillnaden mellan) färgerna 
men färgernas exakta värden kan förändras.

Använd Saturation för diagram vars färger ska vara klara och mättade.

Gammakurvor och svartpunktskompensation
Eftersom ögat inte uppfattar förändringar i väldigt mörka eller ljusa partier lika bra som 
skillnader i de mellanljus/mörka områdena, är det onödigt att lagra en massa information om 
detta samtidigt som det blir mindre plats för att skildra det som verkligen kan uppfattas. 
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Gammakurvor och svartpunktskompensation hanterar detta så se till att 
svartpunktskompensation är påslagen om möjligt.
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Bilaga 4. Mer om PDF-dokument

PDF filformat
Dokumentet skickas till tryckeriet som ett PDF-dokument. Det finns flera olika PDF-format:

• PDF 1.4 och PDF 1.5 kan båda hantera genomskinlighet.

• PDF/X-1a kräver att alla färger är i CMYK (eller dekorfärger).

• PDF/X-3 märker upp alla bilder med rätt ICC-profil men gör ingen konvertering till CMYK 
utan låter tryckeriet sköta det.

• PDF/X-1a och PDF/X-3 baseras båda två på PDF 1.3 som i sin tur inte kan hantera 
genomskinlighet.

47


	Grafisk produktion med fria verktyg
	1. Verktyg/program
	Scribus (formgivning)
	GIMP (bildbehandling)
	Inkscape (vektorillustration)
	LibreOffice
	Öppna filformat

	2. Exempel
	3. Arbetsflöde - teori
	Steg 0. Färghantering
	Steg 1. Manus
	Steg 2. Mall
	Steg 3. Layout
	Steg 4. Bildbehandling
	Steg 5. Korrektur
	Steg 6. Tryckfärdig

	4. Arbetsflöde - praktik
	Steg 0. Färghantering
	Steg 1. Manus
	Steg 2. Mall
	Steg 2a. Ställ in Scribus
	Steg 2b. Färger
	Steg 2c. Stilar
	Steg 2d. Mallsidor

	Steg 3. Layout
	Steg 4. Bildbehandling
	1. Beskärning
	2. Upplösning
	3. Storlek
	4. Nivåer (svart- och vitpunkt)
	5. Kurvor samt intensitet och kontrast
	6. Färgbalans och nyans/mättnad
	7. Retuschering och borttagning av oönskade detaljer
	8. Friläggning
	9. Skärpa
	10. Eventuellt färgseparering
	11. Spara som TIFF
	12. Infoga bilden i Scribus
	8. Friläggning
	Logotyp

	Steg 5. Korrektur
	Steg 6. Tryckfärdig

	5. Fler resurser
	Fri programvara och grafisk produktion
	Öppna typsnitt
	Öppen vektorgrafik
	Övrigt

	Bilaga 1. Färghantering - teori
	Färghantering - en snabbkurs
	Skapa ett färghanterat arbetsflöde

	Bilaga 2. Färghantering - praktik
	Installera en CMS
	Kalibrera skärmen
	Ställ in GIMP
	Ställ in Inkscape
	Ställ in Scribus

	Bilaga 3. Ännu mer om färghantering
	Absolute colorimetric
	Relative colorimetric
	Perceptual och Saturation
	Gammakurvor och svartpunktskompensation

	Bilaga 4. Mer om PDF-dokument
	PDF filformat



